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Microsoft Office Specialist

Exam MO-300

Microsoft 
PowerPoint
This book covers the skills you need to have for certification as a Microsoft 
Office Specialist in PowerPoint 2019 or PowerPoint for Office 365. Specifically, 
you need to be able to complete tasks that demonstrate the following skill sets:

1	 Manage presentations
2	 Manage slides
3	 Insert and format text, shapes, and images
4	 Insert tables, charts, SmartArt, 3D models, and media
5	 Apply transitions and animations

With these skills, you can create and manage the types of presentations that are 
most commonly used in educational and business environments.
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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to 
validate your knowledge of and ability to use applications in the Microsoft Office 
suite. This book has been designed to guide you in studying the types of tasks you  
are likely to be required to demonstrate on Exam MO-300: Microsoft PowerPoint 
(PowerPoint and PowerPoint 2019).

Who this book is for
MOS 2019 Study Guide for Microsoft PowerPoint is designed for experienced computer 
users seeking Microsoft Office Specialist certification in PowerPoint 2019 or the equiv-
alent version of PowerPoint for Office 365.

MOS exams for individual programs are practical rather than theoretical. You must 
demonstrate that you can complete certain tasks or projects rather than simply 
answer questions about program features. The successful MOS certification candidate 
will have at least six months of experience using all aspects of the application on a 
regular basis; for example, using PowerPoint at work or school to create and manage 
presentations and slides, insert and format slide content (including shapes, text, 
tables, charts, SmartArt graphics, images, and media), animate slide content, transition 
between slides, manage multiple versions of a presentation, and prepare presenta-
tions for delivery.

As a certification candidate, you probably have a lot of experience with the program 
you want to become certified in. Many of the procedures described in this book will 
be familiar to you; others might not be. Read through each study section and ensure 
that you are familiar with the procedures, concepts, and tools discussed. In some 
cases, images depict the tools you will use to perform procedures related to the  
skill set. Study the images and ensure that you are familiar with the options available 
for each tool.
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How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate 
to the functional groups covered by the exam. Each chapter is divided into sections 
addressing groups of related skills that correlate to the exam objectives. Each section 
includes review information, generic procedures, and practice tasks you can complete 
on your own while studying. We provide practice files you can use to work through 
the practice tasks and result files you can use to check your work. You can practice the 
generic procedures in this book by using the practice files supplied or by using your 
own files.

Throughout this book, you will find Exam Strategy tips that present information about 
the scope of study that is necessary to ensure that you achieve mastery of a skill set 
and are successful in your certification effort.
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The following table lists the practice files provided for this book.

Folder and objective group Practice files Result files

MOSPowerPoint2019\
Objective1
Manage presentations

PowerPoint_1-1.pptx 
PowerPoint_1-1.png 
PowerPoint_1-2.pptx 
PowerPoint_1-3.pptx 
PowerPoint_1-4.pptx 
PowerPoint_1-5.pptx

PowerPoint_1-1_results.pptx 
PowerPoint_1-2_results.pptx 
PowerPoint_1-4_results.pptx 
PowerPoint_1-5_results.pptx 
1-5_Package (folder) containing: 
  AUTORUN.INF 
  PowerPoint_1-5_results.pptx 
  PresentationPackage (folder) 
  containing: 
      background.jpg 
      button.jpg 
      PresentationPackage.css 
      PresentationPackage.html 
      PresentationPackage.ico 
      shdwLeft.jpg 
      shdwRight.jpg

MOSPowerPoint2019\
Objective2
Manage slides

PowerPoint_2-1.pptx 
PowerPoint_2-1a.docx 
PowerPoint_2-1b.pptx 
PowerPoint_2-2.pptx 
PowerPoint_2-3.pptx

PowerPoint_2-1a_results.pptx 
PowerPoint_2-1b_results.pptx 
PowerPoint_2-2_results.pptx 
PowerPoint_2-3_results.pptx

MOSPowerPoint2019\
Objective3
Insert and format text,  
shapes, and images

PowerPoint_3-1.pptx 
PowerPoint_3-2.pptx 
PowerPoint_3-3.pptx 
PowerPoint_3-3a.jpg 
PowerPoint_3-3b.jpg 
PowerPoint_3-4.pptx 
PowerPoint_3-5.pptx

PowerPoint_3-1_results.pptx 
PowerPoint_3-2_results.pptx 
PowerPoint_3-3_results.pptx 
PowerPoint_3-4_results.pptx 
PowerPoint_3-5_results.pptx

MOSPowerPoint2019\
Objective4
Insert tables, charts, 
SmartArt, 3D models, and 
media

PowerPoint_4-1.pptx 
PowerPoint_4-1.xlsx 
PowerPoint_4-2.pptx 
PowerPoint_4-2.xlsx 
PowerPoint_4-3.pptx 
PowerPoint_4-4.pptx 
PowerPoint_4-4.3mf 
PowerPoint_4-5.pptx 
PowerPoint_4-5.mp3 
PowerPoint_4-5.mp4

PowerPoint_4-1_results.pptx 
PowerPoint_4-2_results.pptx 
PowerPoint_4-3_results.pptx 
PowerPoint_4-4_results.pptx 
PowerPoint_4-5_results.pptx

MOSPowerPoint2019\
Objective5
Apply transitions and 
animations

PowerPoint_5-1.pptx 
PowerPoint_5-2.pptx 
PowerPoint_5-3.pptx

PowerPoint_5-1_results.pptx 
PowerPoint_5-2_results.pptx 
PowerPoint_5-3_results.pptx

http://PresentationPackage.html
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Introduction

Adapt procedure steps
This book contains many images of user interface elements that you’ll work with 
while performing tasks in PowerPoint on a Windows computer. Depending on your 
screen resolution or app window width, the PowerPoint ribbon on your screen might 
look different from that shown in this book. (If you turn on Touch mode, the ribbon 
displays significantly fewer commands than in Mouse mode.) As a result, procedural 
instructions that involve the ribbon might require a little adaptation.

Simple procedural instructions use this format:

➜➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

➜➜ On the Home tab, in the Editing group, click the Find arrow and then, in the 
Find list, click Go To.

If differences between your display settings and ours cause a button to appear differ-
ently on your screen than it does in this book, you can easily adapt the steps to locate 
the command. First click the specified tab, and then locate the specified group. If a 
group has been collapsed into a group list or under a group button, click the list or 
button to display the group’s commands. If you can’t immediately identify the button 
you want, point to likely candidates to display their names in ScreenTips.

The instructions in this book assume that you’re interacting with on-screen elements 
on your computer by clicking (with a mouse, touchpad, or other hardware device). If 
you’re using a different method—for example, if your computer has a touchscreen 
interface and you’re tapping the screen (with your finger or a stylus)—substitute the 
applicable tapping action when you interact with a user interface element.

Instructions in this book refer to user interface elements that you click or tap on the 
screen as buttons, and to physical buttons that you press on a keyboard as keys, to 
conform to the standard terminology used in documentation for these products.
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Ebook edition
If you’re reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at:

MicrosoftPressStore.com/MOSPowerPoint300/detail

Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

twitter.com/MicrosoftPress

http://MicrosoftPressStore.com/MOSPowerPoint300/detail
http://twitter.com/MicrosoftPress
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Taking a Microsoft Office 
Specialist exam
Desktop computing proficiency is increasingly important in today’s business world. 
When screening, hiring, and training employees, employers can feel reassured by 
relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technology 
certification to prove that you already have the skills you need to succeed, saving 
current and future employers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist students and information 
workers in validating their skills with Office programs. The following certification paths 
are available:

■■ A Microsoft Office Specialist is an individual who has demonstrated proficiency 
by passing the Excel Associate, Word Associate, Outlook Associate, or Power-
Point Associate certification exam.

■■ A Microsoft Office Specialist Associate (MOS Associate) is an individual who has 
passed any three of the Associate-level certification exams.

■■ A Microsoft Office Specialist Expert (MOS Expert) is an individual who has 
completed the MOS Associate credential and any two of the three Expert-level 
exams: Access Expert, Word Expert, or Excel Expert.

Selecting a certification path
When deciding which certifications you would like to pursue, assess the following:

■■ The program and program version(s) with which you are familiar

■■ The length of time you have used the program and how frequently you use it

■■ Whether you have had formal or informal training in the use of that program



xiv

Taking a Microsoft Office Specialist exam

■■ Whether you use most or all of the available program features

■■ Whether you are considered a go-to resource by business associates, friends, 
and family members who have difficulty with the program

Candidates for MOS Associate certification are expected to successfully complete a 
wide range of standard business tasks. Successful candidates generally have six or 
more months of experience with the specific Office program, including either formal, 
instructor-led training or self-study using MOS-approved books, guides, or interactive 
computer-based materials.

Candidates for MOS Expert certification are expected to successfully complete more 
complex tasks that involve using the advanced functionality of the program. Success-
ful candidates generally have at least six months, and might have several years, of 
experience with the programs, including formal, instructor-led training or self-study 
using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred 
to as the objective domain) that are derived from studies of how the Office programs 
are used in the workplace. Because these skill standards dictate the scope of each 
exam, they provide critical information about how to prepare for certification. This 
book follows the structure of the published exam objectives.

See Also  For more information about the book structure, see “How this book is organized” in 
the Introduction.

The MOS certification exams are performance based and require you to complete 
business-related tasks in the program for which you are seeking certification. For 
example, you might be presented with a document and told to insert and format 
additional document elements. Your score on the exam reflects how many of the 
requested tasks you complete within the allotted time.

Here is some helpful information about taking the exam:

■■ Keep track of the time. Your exam time does not officially begin until after  
you finish reading the instructions provided at the beginning of the exam. 
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During the exam, the amount of time remaining is shown in the exam instruc-
tion window. You can’t pause the exam after you start it.

■■ Pace yourself. At the beginning of the exam, you will receive information about 
the tasks that are included on the exam. During the exam, the number of com-
pleted and remaining tasks is shown in the exam instruction window.

■■ Read the exam instructions carefully before beginning. Follow all the instruc-
tions provided completely and accurately.

■■ If you have difficulty performing a task, you can restart it without affecting the 
result of any completed tasks, or you can skip the task and come back to it after 
you finish the other tasks on the exam.

■■ Enter requested information as it appears in the instructions, but without dupli-
cating the formatting unless you are specifically instructed to do so. For exam-
ple, the text and values you are asked to enter might appear in the instructions 
in bold and underlined text, but you should enter the information without 
applying these formats.

■■ Close all dialog boxes before proceeding to the next exam item unless you are 
specifically instructed not to do so.

■■ Don’t close task panes before proceeding to the next exam item unless you are 
specifically instructed to do so.

■■ If you are asked to print a document, worksheet, chart, report, or slide, perform 
the task, but be aware that nothing will actually print.

■■ Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 
on its result, not on the method you use to achieve that result (unless a specific 
method is indicated in the instructions).

■■ If a computer problem occurs during the exam (for example, if the exam does 
not respond or the mouse no longer functions) or if a power outage occurs, 
contact a testing center administrator immediately. The administrator will 
restart the computer and return the exam to the point where the interruption 
occurred, with your score intact.

Exam Strategy  This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Exam Strategy paragraphs such as this one.
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Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. If your score meets or exceeds the passing standard (the minimum 
required score), you will be contacted by email by the Microsoft Certification Pro-
gram team. The email message you receive will include your Microsoft Certification 
ID and links to online resources, including the Microsoft Certified Professional site. 
On this site, you can download or order a printed certificate, create a virtual business 
card, order an ID card, review and share your certification transcript, access the Logo 
Builder, and access other useful and interesting resources, including special offers from 
Microsoft and affiliated companies.

Depending on the level of certification you achieve, you will qualify to display one of 
three logos on your business card and other personal promotional materials. These 
logos attest to the fact that you are proficient in the applications or cross-application 
skills necessary to achieve the certification. Using the Logo Builder, you can create a 
personalized certification logo that includes the MOS logo and the specific programs 
in which you have achieved certification. If you achieve MOS certification in multiple 
programs, you can include multiple certifications in one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware, visit:

www.certiport.com/mos

http://www.certiport.com/mos
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Objective group 2

Manage slides
The skills tested in this section of the Microsoft Office Specialist exam for  
Microsoft PowerPoint 2019 relate to creating and managing slides (rather than 
slide content). Specifically, the following objectives are associated with this set 
of skills:

2.1	 Insert slides
2.2	 Modify slides
2.3	 Order and group slides

As you build your presentation by inserting slides, each slide has a specific slide 
layout that governs the layout of the content on the slide. You can modify the 
slide layout and automatically rearrange the slide content at any time. 

If the information you want to share with your audience already exists in 
another presentation, you can merge the content of the existing slides into your 
presentation so that the slides take on the theme colors and fonts of the pre-
sentation. You can hide slides that you don’t want to show in a slideshow (and 
don’t want to delete) or apply specific background colors, patterns, or textures 
to individual slides to make them stand out from the themed content of the 
presentation. You can easily display identifying information in the header and 
footer areas of slides.

By organizing related slides into sections, you can identify and more easily 
manage groups of slides.

This chapter guides you in studying methods of inserting, modifying, ordering, 
and grouping slides.

 

To complete the practice tasks in this chapter, you need the practice files 
contained in the MOSPowerPoint2019\Objective2 practice file folder. 
For more information, see “Download the practice files” in this book’s 
introduction.

2
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Objective 2.1: Insert slides
It can often be simpler to organize the content, or at least an outline, of a presentation 
in a document rather than directly in PowerPoint. Creating a presentation outline within 
a document allows you to see more of the content at one time and consider the presen-
tation content at a higher level. After transferring the content to PowerPoint, you can 
concentrate on the individual slides without worrying about the presentation flow.

Import Word document outlines
It isn’t necessary to manually transfer a presentation outline from a document to indi-
vidual slides. To create an unformatted presentation that includes slides, you can import 
a text file or Word document that contains the slide information. PowerPoint creates 
unformatted Title And Content slides corresponding to the slide titles specified in the 
source file. When creating a presentation from text file content, you can create only slide 
titles, because text files don’t support formatting options that would inform PowerPoint 
of how you want to use the content. When creating a presentation from Word file con-
tent, however, you can format the content by applying multiple heading levels.

Organize your thoughts in Word and then import the outline to create slides
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PowerPoint creates slides, slide titles, and multiple levels of bulleted content based 
on the heading levels assigned within the Word document. PowerPoint uses only the 
headings and no other document content. Paragraphs styled as Title or Heading1 
become slide titles, and paragraphs styled as Heading2 through Heading9 become 
bullet points.

A slide deck created by importing an outline

If you save an outline containing styled headings as a Word document (with the .doc 
or .docx extension) or a Rich Text Format (.rtf) file, you can create a new presentation 
by opening the outline from PowerPoint, or you can add the outline slides to the 
existing presentation by importing the outline.

To prepare a Word document as a presentation outline

1.	 Create a Word document that contains the slide titles and bulleted list content 
for the slides you want. The document can also contain other content.

2.	 In the Word document, apply the Title or Heading1 style to text that equates to 
new slide titles, the Heading2 style to text that equates to first-level bullet points 
on the slide, and the Heading3 style to text that equates to second-level bullet 
points. Then save the file.

2
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To create a presentation based on a Word outline

1.	 Identify a document that contains the correctly styled outline content.

2.	 In PowerPoint, do the following:

a.	 From the Open page of the Backstage view, browse to the folder that 
contains the Word document.

b.	 Click Browse to display the Open dialog box.

c.	 In the Open dialog box, in the File Type list, click All Files or All Outlines.

d.	 Locate the document that contains the outline, and then do either of the 
following to create a presentation populated with slides corresponding to the 
slide titles in the document:

●● Double-click the document.

●● Click the document to select it, and then click Open.

To insert slides based on a Word outline into an existing presentation

1.	 Identify a document that contains the correctly styled outline content.

2.	 Open the presentation you want to insert slides into.

3.	 In the Slides pane, click to position the insertion bar in the location where you 
want to insert the new slides.

4.	 On the Insert tab, in the Slides group, click the New Slide arrow, and then click 
Slides from Outline.

5.	 In the Insert Outline dialog box, browse to the folder that contains the Word 
document, and then double-click the document to insert slides corresponding to 
the slide titles in the document.

Insert slides from another presentation
If the slides you want to use already exist in another presentation, you can easily incor-
porate them into a new presentation. 
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PowerPoint offers multiple ways to reuse slides from one presentation in another:

■■ You can move or copy slides directly between open presentations.

■■ You can import slides from one presentation into another by using the Reuse 
Slides tool. It isn’t necessary to open the source presentation.

■■ If you know in advance that you’ll want to use a slide in multiple presenta-
tions, you can publish it to the slide library on your computer and then reuse 
it from there, without having to track down the presentation or undo any 
presentation-specific modifications that you might have made to the slide.

You can reuse slides from any presentation that you can browse to from File Explorer

2
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To copy slides from an open presentation

1.	 Open the source and target presentations.

2.	 Display the presentation content in Normal view or Slide Sorter view. (The source 
and target presentations don’t have to be in the same view.)

3.	 Drag the slides you want to reuse from the source presentation to the target 
presentation and drop them among the slide thumbnails in the location you 
want them.

To reuse slides from an existing presentation

1.	 In the Thumbnails pane or Slide Sorter pane, click where you want to insert the 
reused slide or slides.

2.	 On the Home tab or Insert tab, in the Slides group, click Reuse Slides. The 
Reuse Slides pane opens, displaying thumbnail representations of presentations 
saved on your computer or to which you have access on OneDrive or SharePoint.

3.	 Do either of the following:

●● Scroll the Reuse Slides pane to locate a presentation from which you want 
to reuse slides. On the presentation thumbnail, click Choose Content.

●● In the Reuse Slides pane, click Browse. In the Choose Content dialog box, 
locate and double-click the presentation containing the slides you want 
to reuse.

4.	 In the Reuse Slides pane displaying the presentation content, click Insert Slide 
on the thumbnail of each slide you want to insert in your presentation.

Tip  By default, reused slides take on the formatting of the presentation into which they are 
inserted. To retain the slides’ source formatting, select the Use Source Formatting check box in 
the Reuse Slides pane before inserting the slides.

Insert slides and select slide layouts
When you insert a slide into a presentation, PowerPoint inserts it with the default 
layout immediately after the current slide. If you want to add a slide with a different 



59

Objective 2.1: Insert slides

layout, select the layout you want from the New Slide gallery. The available layouts 
and their design depend on the template used to create the presentation.

Thumbnails depict the content of each slide layout

After you insert a slide, you can apply a different layout at any time, or if you make 
changes to the slide structure, you can reset the layout.

If you want to insert a slide that is similar to an existing slide, you can duplicate the 
existing slide and then change it instead of having to create the slide from scratch.

To add slides

➜➜ In Normal view or Slide Sorter view, click the slide that you want the new slide to 
follow, and then on the Home tab, in the Slides group, do one of the following:

●● To add a slide of a specific layout, click the New Slide arrow, and then click 
the slide layout you want to add.

●● To add a slide of the currently selected layout, click the New Slide button or 
press Ctrl+M.

●● To add a slide that is identical to the currently selected slide, click the New 
Slide arrow, and then click Duplicate Selected Slides.

2
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➜➜ Right-click a slide, and then do one of the following:

●● To add a slide of the currently selected layout, click New Slide.

●● To add a slide that is identical to the currently selected slide, click  
Duplicate Slide.

To apply a slide layout

1.	 Do either of the following:

●● To apply the layout to only one slide, display the slide in Normal view or 
select it in Slide Sorter view.

●● To apply the layout to multiple slides, display the presentation in Slide Sorter 
view, and then select the slides you want to modify.

2.	 On the Home tab, in the Slides group, click the Slide Layout button, and then 
click the layout you want to apply.

To reset slide content to the layout defaults

➜➜ Select the slide or slides you want to reset. Then on the Home tab, in the Slides 
group, click the Reset button.

To delete slides

➜➜ Right-click a slide or selected slides, and then click Delete Slide.

See Also  For information about inserting a Summary Zoom slide, see “Objective group 3: 
Insert and format text, shapes, and images.”
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Objective 2.1 practice tasks
The practice files for these tasks are in the MOSPowerPoint2019\ 
Objective2 practice file folder. The folder also contains a result file that you 
can use to check your work.

➤➤ Open the PowerPoint_2-1 presentation and do the following:

❑❑ From within PowerPoint, open the PowerPoint_2-1a document from 
the practice file folder to create a presentation based on the outline 
in the document. (If you encounter an error opening the file, use the 
Insert Slides from Outline method to import the outline content.)

❑❑ Delete the original blank slide from the presentation, leaving only 
the slides created from the outline.

❑❑ Save the presentation as PowerPoint_2-1a.pptx.

➤➤ Start or switch to File Explorer and do the following:

❑❑ Display the contents of the practice file folder.

❑❑ Open the PowerPoint 2-1a document and compare it to the 
PowerPoint_2-1a presentation to identify the relationship between 
the outline levels and the slide content.

❑❑ Close the PowerPoint 2-1a document and File Explorer.

➤➤ Save the PowerPoint_2-1a presentation. Open the  
PowerPoint_2-1a_results presentation. Compare the two 
presentations to check your work. Then close the  
open presentations.

➤➤ Open the PowerPoint_2-1b presentation and do the following:

❑❑ Immediately following the title slide (slide 1), insert a new slide with 
the default Title and Content layout.

❑❑ Delete the blank slide from the end of the presentation.

❑❑ After slide 7 (Falling Rates), insert a new slide with the Winter Section 
Header slide layout. In the title placeholder, enter Winter Wonders.
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❑❑ Duplicate slide 6 (Water Conservation) and then move the duplicate 
to follow the Winter Wonders section opener slide.

❑❑ Display slide 4 (Grow Your Own Gardener). Change the slide layout 
from Picture with Caption to Comparison. Note the effect on the 
existing slide content.

➤➤ Save the PowerPoint_2-1b presentation. Open the 
PowerPoint_2-1b_results presentation. Compare the two 
presentations to check your work. Then close the  
open presentations.
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Objective 2.2: Modify slides
It is generally best practice within a presentation to display information using a consis-
tent appearance and following a consistent flow. At times you might find it necessary 
to remove a slide from a presentation, to emphasize a slide by using a different back-
ground, or to include identifying information in the header or footer area of one or 
more slides, handouts, or notes pages.

Hide and unhide slides
If you decide not to include a slide when you deliver a presentation but you don’t 
want to delete the slide entirely, you can hide the slide. Then PowerPoint will skip over 
that slide during delivery. Hidden slides are still visible in Normal view and Slide Sorter 
view, but they appear shaded and have a slash through the slide number.

Hidden slide

Hidden slides remain in the presentation but aren’t displayed in a slideshow

2



64

Objective group 2  Manage slides

To hide or unhide slides

➜➜ Right-click a slide or selected slides, and then click Hide Slide.

Tip  The Hide Slide command name stays the same regardless of whether a slide is hidden. 
When the selected slide is hidden, the command appears to be selected.

Modify individual slide backgrounds
You can customize the background of an individual slide by adding a solid color, a 
color gradient, a texture, or even a picture.

In the Format Background pane, you can specify the colors, texture, pattern, or picture 
that appear on the background of the current slide or slide master.

A solid or gradient color corresponding to the color scheme applied to the presenta-
tion can provide a simple yet elegant slide background.

You can configure a more complex slide background by selecting one of the 15 built-in 
textures or 48 patterns that can be customized with any two colors. Each texture is a 
small graphic that is tiled on the slide and designed to repeat gracefully, both horizon-
tally and vertically.

Texture gallery Pattern gallery

The Paper Bag texture applied to a slide, and other texture and pattern options
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If none of the textures meets your requirements, you can tile a picture of your own. 
You can customize a slide background even further by using a picture as the back-
ground. Because most pictures are too busy to support the inclusion of other content 
on the slide, these are often best used for title slides or other slides that do not have to 
support a lot of content.

Picture backgrounds can convey additional information on slides without text

Tip  If you want to add a watermark, such as the word Draft or Confidential, to the background 
of your slides, add the text to the background of the slide master.

To display the Format Background pane

➜➜ On the Design tab, in the Customize group, click the Format Background button.

➜➜ Right-click the slide, and then click Format Background.

2



66

Objective group 2  Manage slides

To modify individual slide backgrounds

1.	 In Normal view or Slide Sorter view, select the slide or slides you want to modify.

2.	 Display the Format Background pane.

Slide backgrounds can be simple or complex

3.	 In the Format Background pane, do one of the following:

●● Click Solid fill, and then select the color and set the transparency.

●● Click Gradient fill, and then select the type, direction, angle, and gradient 
stop locations and colors. For each color, set the position, transparency,  
and brightness.

●● Click Picture or texture fill, and then select a local or online picture, or select 
a texture. Then set the transparency and, if appropriate, select the Tile picture 
as texture check box or set the offset, scale, alignment, or mirror type.

●● Click Pattern fill, and then select a pattern, foreground color, and back-
ground color.
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4.	 If you want to remove the background graphics applied by the slide master, 
select the Hide background graphics check box.

5.	 If you want to apply the background settings to the slide master, click Apply to All.

Insert slide headers, footers, and page numbers
To ensure consistency across slides in a presentation, slide header and footer elements 
are usually managed on slide masters, notes masters, and handout masters. However, 
you can configure the display of information in slide footers, and in the headers and 
footers of speaker notes pages and handouts, without modifying the slide master.

The following table describes the information you can display in the slide footer. You 
have the option of configuring the footer for one slide, for all slides, or for all slides other 
than the title slide. The footer configuration applies to on-screen and printed slides.

Location Information

Left side Static or dynamically updating date and/or time

Center Text of your choice (approximately 50 characters per line up to  
200 characters in the default space)

Right side Slide number

The following table describes the information you can display on speaker notes pages 
and handouts. The header and footer configuration applies to the speaker notes 
pages and handouts for all slides in the presentation.

Area Location Information

Header Left side Text of your choice (approximately 35 characters per line up 
to 175 characters in the default space above the slide)

Header Right side Static or dynamically updating date and/or time

Footer Left side Text of your choice (approximately 35 characters per line 
extending up from the lower-left corner of the page)

Footer Right side Page number

2
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To configure slide footer content

1.	 On the Insert tab, in the Text group, click Header & Footer.

2.	 On the Slide tab of the Header and Footer dialog box, select the check boxes 
for the elements you want to display. Options include Date and time, Slide 
number, and Footer.

3.	 If you select the Date and time check box, do either of the following:

●● Select the Update automatically option, and then select the date and time 
format you want from the list.

●● Select the Fixed option, and then enter the date and time you want  
to display.

4.	 If you select the Footer check box, enter the text that you want to display in the 
center footer section.

5.	 To suppress the footer elements on the title slide of the presentations, select the 
Don’t show on title slide check box.

Selecting an element outlines the corresponding location in the preview area

6.	 To save your changes, do either of the following:

●● To display the footer only on the current slide, click Apply.

●● To display the footer on all slides in the presentation, click Apply to All.
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To configure notes page and handout header and footer content

1.	 On the Insert tab, in the Text group, click the Header & Footer button.

2.	 Click the Notes and Handouts tab.

3.	 Select the check boxes for the elements you want to display. Options include 
Date and time, Page number, Header, and Footer.

4.	 If you select the Date and time check box, do either of the following:

●● Select the Update automatically option, and then select the date and time 
format you want from the list.

●● Select the Fixed option, and then enter the date and time you want  
to display.

5.	 If you select the Header check box, enter the text that you want to display on the 
left side of the header.

6.	 If you select the Footer check box, enter the text that you want to display on the 
left side of the footer.

7.	 To save your changes, click Apply to All.

2
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Objective 2.2 practice tasks
The practice file for these tasks is in the MOSPowerPoint2019\Objective2 
practice file folder. The folder also contains a result file that you can use to 
check your work.

➤➤ Open the PowerPoint_2-2 presentation and do the following:

❑❑ Hide the Falling Rates section opener (slide 6) and the blank slide 
that follows it (slide 7).

❑❑ Format the background of only the title slide to display the Water 
droplets texture.

❑❑ Configure the slide footer settings to display the footer text  
My Presentation and the slide number on all slides other than 
title slides. Then verify that the title slide and section openers don’t 
display the footer content and the other slides do.

➤➤ Save the PowerPoint_2-2 presentation. Open the  
PowerPoint_2-2_results presentation. Compare the two 
presentations to check your work. Then close the  
open presentations.
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Index
NUMBERS
3D models

animating, 175–176
inserting, 155–156
modifying view, 157–158
types of, 154

35mm Slides slide size, 17

A
A3 Paper/A4 Paper/B4 (ISO) Paper/B5 (ISO) 

Paper slide size, 17
accessibility, alternative text, 108–109
Accessibility Checker, 40–41, 43
aligning

images, 113–115
shapes, 113–115
text, 76, 79

in tables, 130
text boxes, 113–115

alignment tools, viewing, 112–113
Alt Text pane, opening, 109
alternative text

for graphic elements, 108–109
for hyperlinks, 89

angles of shapes, modifying, 104
animated GIFs, creating from presentations, 51
animating

3D models, 175–176
configuring

effects, 176–181
motion paths, 181–183
triggers and timing, 183–184

graphic elements, 172–175
selecting animations, 179
text, 172–175, 180–181
timing of, 178, 183–184
types of animations, 172

Animation pane, opening, 175
Animation Style dialog box, opening, 180
arrive animations (3D models), 176
audio clips

embedding, 160–161

inserting, 160–163
playback options, 163–165
recording, 161
transitioning, 164
trimming, 164

audio icons, modifying, 162
axes, 136

adding/removing, 138
formatting, 141

axis labels, 136
adding/removing, 138

B
backgrounds

of handouts, modifying, 9
of images, removing, 97–99
of notes pages, modifying, 11–12
of slide masters, modifying, 5–6
of slides, modifying, 64–67

Banner slide size, 17
brightness of images, modifying, 100
bulleted lists, 81–85

changing bullet style, 82–83
converting text to, 82
converting to text, 85
creating SmartArt graphics from, 148
demoting list items, 84
hanging indents in, 85
promoting list items, 84

C
capitalization of text, 76, 78
capturing screenshots and clippings,  

95–96
category axis, 136
cells (in tables)

formatting, 130
merging, 128
selecting, 126
setting margins, 130
splitting, 127



190

changing

changing. See modifying
character spacing, 76, 78–79
chart area, 136

formatting, 141
charts

animating, 172–175
creating and inserting, 133–135
elements of, 136–137
formatting, 140–143
modifying, 135–140
resizing, 137, 139
rotating, 140

clearing manual text formatting, 80
clippings, inserting, 95–96
closing

Comments pane, 46
Handout Master view, 10
Notes Master view, 12
Slide Master view, 5

collaboration preparations
comment management, 44–47
exporting presentations to other formats, 

49–51
inspecting presentations for issues,  

38–44
password protection, 36–38
preserving content, 47–48
restricting editing, 35

color
after animations, 180
of images, modifying, 100
of SmartArt graphics, modifying, 151
of text, 76, 78
of text boxes, 106

columns
in tables

deleting, 127
inserting, 127
resizing, 128
selecting, 126

of text, 80–81
comments, 44–47

deleting, 47
editing, 46
inserting, 46
moving among, 46
replying to, 46
viewing, 46
viewing/hiding icons, 46

Comments pane
closing, 46
opening, 45–46

Compatibility Checker, 42, 44
compressing media content, 47, 48
content

on handout masters, inserting  
placeholders, 9

on notes masters, inserting  
placeholders, 11

preserving, 47–48
scaling, 18
on slide layouts, inserting placeholders, 7
on slide masters, modifying, 2–5

contrast of images, modifying, 100
converting

bulleted and numbered lists to text, 85
text

to bulleted lists, 82
to numbered lists, 83

copying
animations, 175
slides, 58
text formatting, 80

cropping
images, 97–99
video windows, 163

Custom slide size, 17
custom slideshows, creating, 29–31
cycle diagrams, 146

D
data labels, 136

adding/removing, 138
data markers, 136

formatting, 141
data series, 136
data tables, 137

adding/removing, 138
formatting, 141, 143

decorative, marking graphic elements as, 109
default shapes, setting, 107
deleting. See also removing

comments, 47
passwords for presentations, 38
shapes in SmartArt graphics, 151
table rows/columns, 127
tables, 125
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guides

demoting
bulleted list items, 84
shapes in SmartArt graphics, 150

diagrams. See SmartArt graphics
direction of text, 76, 79
discarding image changes, 100
displaying. See opening; viewing
Document Inspector, 38–39, 43
duplicating slide layouts, 6
duration of transitions, 187

E
editing

comments, 46
hyperlinks, 89
restricting, 35

effects
after animations, 180
for images, 99–100
for text, 76, 78
of text boxes, modifying, 107

email messages, hyperlinks to create, 88–89
embedding

audio clips, 160–161
Excel worksheets, 124
fonts, 48

emphasis animations, 172
entrance animations, 172
error bars, adding/removing, 138
Excel

embedded worksheets, 124
modifying, 125

linked worksheets, 125
creating charts from, 133–135
resizing, 125
updating, 125

pasting data as table, 124
exit animations, 172
exporting presentations to other formats, 49–51

F
file properties of presentations, setting, 19–20
files

hyperlinks to, 88
inserting images from, 95

fill color of text boxes, 106
flipping text boxes, 105

fonts, 76, 77
embedding, 48

footers on slides, inserting, 67–69
Format Background pane, opening, 65
Format Painter, 80
Format pane, opening, 142–143
formatting. See also modifying

charts, 140–143
retaining source formatting, 58
shapes, 105–107
tables, 129–130
text, 76–85, 107–108

alignment, 79
bulleted and numbered lists, 81–85
capitalization, 78
character spacing, 78–79
clearing manual formatting, 80
color, 78
copying existing formatting, 80
direction, 79
fonts, 77
indentation, 79
line spacing, 79
multiple columns, 80–81
options for, 76–77
size, 77–78
styles and effects, 78
in tables, 130

text boxes, 105–107

G
GIFs, creating from presentations, 51
gradients of text box fills, 107
Grayscale print setting, 16, 24, 25
gridlines

in charts, 136
adding/removing, 139
formatting, 141, 143

defined, 112
managing, 113
viewing/hiding, 113

grouping
images, 115–116
shapes, 115–116
slides into sections, 71–72

guides
defined, 112
managing, 113
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Handout Master view

H
Handout Master view, 16

closing, 10
switching to, 9

handout masters
modifying, 8–10
printing handouts, 25

hanging indents in bulleted and numbered  
lists, 85

headers on slides, inserting, 67–69
hiding

comment icons, 46
gridlines, 113
rulers, 113
slides, 63–64
smart guides, 114

hierarchy diagrams, 146
highlighter in Presenter View, 33
hyperlinks, inserting, 87–89

I
icons for animation categories, 178
images

aligning, 113–115
alternative text, inserting, 108–109
applying styles and effects, 99–100
filling text boxes with, 107
grouping, 115–116
inserting

local and online images, 94–95
screenshots and clippings, 95–96
on slide masters, 6

resizing and cropping, 97–99
scaling, 19
stacking order, 116–118

importing Word document outlines, 54–56
indenting

bulleted and numbered lists, 85
text, 76, 79

Insert Hyperlink dialog box, opening, 88
inserting

3D models, 155–156
alternative text, 108–109
audio clips, 160–163
axis labels, 138
chart axes, 138
chart gridlines, 139

chart titles, 138
charts, 133–135
comments, 46
content placeholders

on handout masters, 9
on notes masters, 11
on slide layouts, 7

data labels, 138
data tables, 138
error bars, 138
headers, footers, page numbers on slides, 

67–69
images

local and online images, 94–95
screenshots and clippings, 95–96
on slide masters, 6

legends, 139
lines/trendlines, 139
links, 87–92

hyperlinks, 87–89
Zoom link slides, 90–92

screen recordings, 162
shapes, 102–103

in SmartArt graphics, 150
slide layouts, 6
slides, 54–60

importing Word document outlines, 
54–56

from other presentations, 56–58
selecting layouts for, 58–60

table columns, 127
table rows, 127
tables, 122–125
text, 107–108

in SmartArt graphics, 150
text boxes, 102
video clips, 160–163

inspecting presentations for issues,  
38–44

J
jump & turn animations (3D models), 176

L
laser pointer in Presenter View, 33
leave animations (3D models), 176
Ledger Paper slide size, 17



193

On-screen Show slide size

legends, 136
adding/removing, 139
formatting, 141

Letter Paper slide size, 17
line charts, adding/removing lines/trendlines, 139
line spacing, 76, 79
lines, adding/removing in line charts, 139
linking to Excel worksheets, 125
links, inserting, 87–92

hyperlinks, 87–89
Zoom link slides, 90–92

list diagrams, 146
local images

defined, 94
inserting, 95

local video clips, inserting, 162

M
margins of table cells, setting, 130
matrix diagrams, 147
media content, compressing, 47, 48
merging table cells, 128
Microsoft Office Compatibility Pack for Word, 

Excel, and PowerPoint File Formats, 42
modifying. See also formatting

3D model views, 157–158
animation order, 181
audio icons, 162
charts, 135–140
content on slide masters, 2–5
content placeholders

on handout masters, 9
on notes masters, 11
on slide layouts, 8

embedded Excel worksheets, 125
handout masters, 8–10
image brightness, contrast, color, 100
motion paths, 181–183
notes masters, 10–12
order of slides, 72–73
page orientation

of handouts, 9
of notes pages, 11

passwords for presentations, 37
properties of presentations, 19–20
shape angles, 104
shape vertices, 104
slide layouts, 6–8

slide size, 16–19
slides, 63–69

backgrounds, 64–67
headers, footers, page numbers, 67–69
hiding, 63–64

SmartArt graphics, 148–151
color scheme, 151

Summary Zoom slides, 91
table structure, 125–128
text. See formatting, text
text box effects, 107
text box outlines, 107
themes/backgrounds of slide masters, 5–6
transition options, 170
video windows, 162

monochromatic formats, 16
motion paths, 172, 181–183
moving

3D models, 158
among comments, 46
chart elements, 140
shapes in SmartArt graphics, 150–151
slides within presentations, 72–73

multiple table elements, selecting, 126–127

N
Normal view, 15
Notes Master view, 16

closing, 12
switching to, 11

notes masters
modifying, 10–12
printing notes, 25

Notes Page view, 16, 23
Notes pane, 23
numbered lists, 81–85

changing number style, 83–84
converting text to, 83
converting to text, 85
hanging indents in, 85

O
online images

defined, 94
inserting, 95

online video clips, inserting, 162
On-screen Show slide size, 17
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opening

opening. See also viewing
Alt Text pane, 109
Animation pane, 175
Animation Style dialog box, 180
Comments pane, 45–46
Format Background pane, 65
Format pane, 142–143
Insert Hyperlink dialog box, 88
presentations with passwords, 36
Selection pane, 117
Text pane, 148

ordering objects, 116–118
outlines (text boxes), modifying, 107
outlines (Word), importing, 54–56
Overhead slide size, 17

P
Package For CD feature, 49, 50
page numbers on slides, inserting, 67–69
page orientation

of handouts, modifying, 9
of notes pages, modifying, 11

paragraph spacing, 76, 79
password protection, 36–38
pasting Excel data as table, 124
path effects. See motion paths
pen in Presenter View, 33
picture diagrams, 147
picture frame styles, 99
placeholders. See content
playback options for audio/video clips, 163–165
plot area, 136

formatting, 141
plotting charts by rows, 135
presentations

collaboration preparations
comment management, 44–47
exporting presentations to other formats, 

49–51
inspecting presentations for issues, 38–44
password protection, 36–38
preserving content, 47–48
restricting editing, 35

handout masters, modifying, 8–10
notes masters, modifying, 10–12
print settings, 23–25
properties, setting, 19–20
slide masters

content modifications, 2–5
slide layout modifications, 6–8
theme/background modifications, 5–6

slides
grouping into sections, 71–72
inserting, 54–60
modifying, 63–69
reordering, 72–73
resizing, 16–19
transitioning, 168–170

slideshows
creating custom, 29–31
Presenter View, 31–33
rehearsing timing, 28–29
setting options, 27–28

views, types of, 15–16
Presenter View, 31–33
preserving content, 47–48
previewing

animations, 175
handouts, 9

print settings for presentations, 23–25
process diagrams, 146
promoting

bulleted list items, 84
shapes in SmartArt graphics, 150

properties of presentations, setting, 19–20
Pure Black And White print setting, 16, 24, 25
pyramid diagrams, 147

Q
Quick Layouts, 136–137
Quick Styles

in charts, 140
in tables, 130

R
Reading view, 15
recording

audio clips, 161
screen recordings, 162

regrouping objects, 116
rehearsing slideshow timing, 28–29
relationship diagrams, 146
removing. See also deleting

animations, 175
axis labels, 138
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slide layouts

chart axes, 138
chart gridlines, 139
chart titles, 138
data labels, 138
data tables, 138
error bars, 138
hyperlinks, 89
image backgrounds, 97–99
legends, 139
lines/trendlines, 139
slide layouts from slide masters, 7
transitions, 170

renaming
sections, 72
slide layouts, 7

reordering slides, 72–73
replacing shapes, 103
replying to comments, 46
resetting SmartArt graphics, 151
resizing

chart elements, 140
charts, 137, 139
images, 97–99
linked Excel worksheets, 125
shapes, 103–105
slides, 16–19
table elements, 128
tables, 128
text boxes, 103–105
video windows, 162–163

restricting editing, 35
retaining source formatting, 58
rotating

3D models, 158
charts, 140
motion paths, 182
text boxes, 104–105

rows
plotting charts by, 135
in tables

deleting, 127
inserting, 127
resizing, 128
selecting, 126

rulers
defined, 112
viewing/hiding, 113

S
scaling

content, 18
images, 19

screen recordings, inserting, 162
screenshots, inserting, 95–96
Section Zoom links, 90, 92
sections

creating, 71–72
renaming, 72

selecting
animations, 179
chart elements, 139
slide layouts for inserted slides, 58–60
table elements, 126–127
tables, 127
worksheet data, 135
worksheets, 135

Selection pane
opening, 117
reordering objects, 117

series axis, 136
shape styles, 140, 141–142
shapes

adding and formatting text, 107–108
aligning, 113–115
alternative text, inserting, 108–109
animating, 172–175
formatting, 105–107
grouping, 115–116
inserting, 102–103
replacing, 103
resizing, 103–105
setting as default, 107
in SmartArt graphics

deleting, 151
inserting, 150
moving, 150–151
promoting/demoting, 150

stacking order, 116–118
size of slides, modifying, 16–19
size of text, 76, 77–78
slide layouts

defined, 2
for inserted slides, selecting, 58–60
modifying, 6–8
specifying elements on slide master, 4–5
types of, 2
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Slide Master view

Slide Master view, 16
closing, 5
switching to, 4

slide masters
content

modifying, 2–5
scaling, 18

images, scaling, 19
slide layouts, modifying, 6–8
themes/backgrounds, modifying, 5–6

Slide Show view, 15
Slide Sorter view, 15
Slide Zoom links, 91, 92
slides

copying, 58
grouping into sections, 71–72
hyperlinks to, 88
inserting, 54–60

importing Word document outlines, 
54–56

from other presentations, 56–58
selecting layouts for, 58–60

modifying, 63–69
backgrounds, 64–67
headers, footers, page numbers, 67–69
hiding, 63–64

reordering, 72–73
resizing, 16–19
retaining source formatting, 58
titles, viewing, 73
transitioning, 168–170
Zoom link slides, inserting, 90–92

slideshows
custom, creating, 29–31
Presenter View, 31–33
setting options, 27–28
timing, rehearsing, 28–29

smart guides, 112, 114
SmartArt graphics

adding/modifying content, 148–151
animating, 172–175
creating, 147–148
types of, 146–147

sound. See also audio clips
in animations, 180
in transitions, 170

speaker notes. See notes masters
splitting table cells, 127
stacking order, 116–118

standard view, applying to 3D models, 158
structure of tables, modifying, 125–128
styles

of charts, 140, 141
of images, 99–100
of shapes, 140, 141–142
of SmartArt graphics, 151
of tables, 130
of text, 76, 78
of text boxes, 106

Summary Zoom slides, 90, 91
swing animations (3D models), 176
switching

to Handout Master view, 9
to Notes Master view, 11
to Slide Master view, 4

T
tables

animating, 172–175
changing structure, 125–128
creating and inserting, 122–125
deleting, 125
formatting, 129–130
resizing, 128
selecting, 127
updating data, 125

testing hyperlinks, 89
text

adding to shapes and text boxes,  
107–108

alternative text, inserting, 108–109
animating, 172–175, 180–181
formatting, 76–85, 107–108

alignment, 79
bulleted and numbered lists, 81–85
capitalization, 78
character spacing, 78–79
clearing manual formatting, 80
color, 78
copying existing formatting, 80
direction, 79
fonts, 77
indentation, 79
line spacing, 79
multiple columns, 80–81
options for, 76–77
size, 77–78
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zooming 3D models

styles and effects, 78
in tables, 130

in SmartArt graphics, inserting, 150
text boxes

adding and formatting text, 107–108
aligning, 113–115
alternative text, inserting, 108–109
flipping, 105
formatting, 105–107
inserting, 102
resizing, 103–105
rotating, 104–105
stacking order, 116–118

Text pane, opening, 148
textures, filling text boxes with, 107
themes of slide masters, modifying, 5–6
timing

of animations, 178, 183–184
of slideshows, rehearsing, 28–29
of transitions, 187

titles
of charts, 137

adding/removing, 138
formatting, 141

of slides, viewing, 73
transitioning

audio/video clips, 164
slides, 168–170
timing of, 187

transparency of text box fills, 107
trendlines, adding/removing in line charts, 139
triggers for animations, 183–184
trimming audio/video clips, 164
turntable animations (3D models), 176

U
ungrouping objects, 116
updating

linked Excel worksheets, 125
table data, 125

V
value axis, 136
vertices of shapes, modifying, 104

video windows
cropping, 163
modifying, 162
resizing, 162–163

videos
creating from presentations, 50–51
inserting clips, 160–163
playback options, 163–165
transitioning, 164
trimming, 164

viewing. See also opening
alignment tools, 112–113
comment icons, 46
comments, 46
gridlines, 113
presentations, types of views, 15–16
rulers, 113
slide layout names/usage, 6
slide titles, 73

W
watermarks on slides, 65
webpages, hyperlinks to, 88
Widescreen slide size, 17
Word, inserting tables from, 124
Word document outlines, importing, 54–56
WordArt, 108

in charts, 140, 142
in tables, 130

worksheets (Excel)
embedded worksheets, 124

modifying, 125
linked worksheets, 125

creating charts from, 133–135
resizing, 125
updating, 125

selecting, 135

Z
Zoom link slides, inserting, 90–92
zooming 3D models, 158
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